
 
 
 
 
 
 

VENABLE WINDOWS VERSION 4.5 
RLC SOFTWARE AND HARDWARE 

MANUAL 
 

FOR 
 

SERIES 43xx/51xx/63xx/74xx/88xx/350c SYSTEMS 
 

AND 
 

LEGACY MODELS 350/3120/3215/3225/3235 
 
 
 
 
 

Venable Instruments 
8656 SH 71 West, Bldg. E 

Cuesta Center 
Austin, TX 78735 

 
512-949-3100 

 
www.venableinstruments.com

Document Version 4.5.0 

http://www.venableinstruments.com/


TABLE OF CONTENTS 
 
 
TOPICS PAGE 
 
Introduction ..................................................................................................................... 3 
System Overview ............................................................................................................ 4 
Installation Procedure for use with USB Interface ........................................................... 7 
Installation Procedure for use with GPIB Adapter ........................................................... 9 
Settings Window ........................................................................................................... 12 
RLC Control Panel ........................................................................................................ 14 
Measurement Tab ......................................................................................................... 14 

Open Circuit Sweep................................................................................................... 16 
Closed Circuit Sweep ................................................................................................ 16 

Modeling Tab ................................................................................................................ 18 
Reporting Tab ............................................................................................................... 20 
Working with Documents, Views, and Data Sets .......................................................... 21 

Manipulating Data Set Properties .............................................................................. 22 
Manipulating Graph Properties .................................................................................. 23 
Working with Slide Bars............................................................................................. 24 
Math Operations ........................................................................................................ 25 

Appendix A - The RLC Box ........................................................................................... 26 
Appendix B – Specifications.......................................................................................... 27 

Calibration Specifications for 5140, 63xx, 74xx, 88xx & 350c Analyzers................... 27 
RLC Specifications .................................................................................................... 30 
Specifications: Venable 350c, 3 channel, 5, 20, and 40MHz Models ......................... 31 
Specifications: Venable 5140, 2 channel, 40MHz ................................................... 32 
Specifications: Venable 63XX, 2 channel, 5, 20, and 40MHz Models ........................ 33 
Specifications: Venable 74XX, 4 channel, 5, 20, and 40MHz Models ........................ 34 
Specifications: Venable 88XX, 23 channel, 5, 20, and 40MHz Models ...................... 35 

APPENDIX C- Hardware Description of Venable Analyzers ......................................... 37 
350C Front Panel....................................................................................................... 37 
350C/63XX/74XX/88XX Rear Panel .......................................................................... 38 
5140 Front Panel ....................................................................................................... 39 
5140 Rear Panel........................................................................................................ 40 
63XX Front Panel ...................................................................................................... 41 
74XX Front Panel ...................................................................................................... 42 
88XX Front Panel ...................................................................................................... 43 

 

05/21/19  ii



Introduction 
This manual describes the Venable Windows RLC Software. 
 
This manual is provided in printed form with the hardware Analyzer, in electronic form in 
the software and in electronic form on the download site.  The latest version of this 
manual can always be found on Venable’s download site beside the current software 
installation package. The version in the current software installation can be reached 
using the menu item Help  Venable RLC Manual. 
 
The installation portion of this manual covers both the hardware and software setup.   
 
The Software works with a number of different hardware models of Frequency 
Response Analyzers.  Separate licenses must be obtained from Venable for each type 
of Analyzer the Software will work with.  A separate “Venable type Software” shortcut is 
installed in the Windows “Start>>All Programs” menu for each licensed type. 
 
The Software adapts to the differences between Analyzers by showing different 
Analyzer Control dialogs and making minor changes in other dialogs.  The main 
Software Window will display the current licensed type as part of the window title in the 
title bar. 
 
This manual will point out the differences between Analyzer types where it matters.  
Type specific screenshots of several dialogs are given; please look at the information 
relevant to the type of Analyzer you are working with. 
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System Overview 
 
The Venable RLC Windows Software, in combination with a supported Frequency 
Response Analyzer (FRA), allows you to measure the frequency response of RLC 
circuits. You can calibrate your RLC box, run measurements through a range of 
frequencies, build a theoretical model based on the empirical data and generate reports. 
 
The RLC software is controlled mainly through the RLC Control Panel, which has four 
components: Setup, Measurement, Model, and Report. 
 
The hardware portion consists of a FRA, which is used for making measurements of 
gain, phase, and voltage versus frequency and various accessories for coupling the 
FRA to the electrical, mechanical, or thermal system under test.  Supported FRA’s are 
the following1.  The list is grouped by Software license type: 
 

• RLC350 license type supporting Venable models 350, 220 and 250 
• RLC3120 for Venable model 3120 
• RLC3215 for Venable model 3215 
• RLC3225 for Venable model 3225 
• RLC3235 for Venable model 3235 
• RLC4000 for Venable models 43xx, 63xx, 74xx, 88xx and 350c 
• RLC5000 for Venable models 51xx 

 
The FRA’s are controlled in one of two ways: 
 
1.  Through a standard USB cable using drivers from the Keysight IO Libraries Suite, 

version 18.1 or later (Windows XP is not supported). 
 (For Windows XP users, Use Venable Software version 5.4 and version 17.1 of 

the Keysight IO library drivers) 
 
2.  Through a National Instruments GPIB board using version 17.6.0 or later of the 

National Instruments ni488.2 drivers (Windows XP not supported). 
 (For Windows XP users, Use Venable Software version 5.4 and version 2.8.1 of 

the ni488.2 drivers) 
 
The software portion runs on any personal computer using Microsoft Windows 7, 8 or 
10, 32-bit or 64-bit.  
 
Data can be saved, recalled, and printed in the form of graphs on any Windows-
compatible printer in black-and-white or color if the printer has that capability.  Graph 
types supported are gain and phase vs. frequency (semi-log), reactance vs. frequency 
(log-log with lines for constant capacitance and inductance), and Nyquist (log outside of 
the unity gain circle and linear inside the unity gain circle). 
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The Venable software is protected against illegal copying and use. In order to run, first it 
must be activated. On installation you are prompted for the Software Serial Number 
given to you by Venable and a Wizard walks you through the steps to activate it. 
 
New Features of the Venable System Version 4.5.0 Software 
 

• National Instruments driver support is updated to version 17.6 of the NI GPIB 
drivers. 

• Keysight IO Libraries driver support is updated to version 18.1. 
 
New Features of the Venable System Version 4.4.1 Software 
 

• Communication to 350a/b, 3120 and 3200s broke in 4.4.0. Fixed.  
• Math button on menu fixed. 

 
New Features of the Venable System Version 4.4.0 Software 
 

• Added Peak Voltage Selector to correct for input attenuation variances in data 
plots.  

 
New Features of the Venable System Version 4.3.1 Software 
 

• The software adds support for analyzer model 5140.  
• The software adds support for analyzer models 7405, 7420 & 7740. 
• Adds alternative channel selectivity on models 350c and 74xx.  

 
New Features of the Venable System Version 4.2.1 Software 
 

• The software adds support for analyzer models 8805, 8820 & 8840.  
 
New Features of the Venable System Version 4.1.4 Software 
 

• The software has voltage limit warnings added for the Venable Series 
43xx/63xx/350c System analyzers.  When Input and Output Impedances are 
changed, the analyzer can be severely damaged at much lower voltages. 

 
New Features of the Venable RLC System Version 4.1 Software 
 

• The software has been updated to work with the USB interface on the Venable 
Series 43xx/63xx/350c System analyzers. 

 
New Features of the Venable RLC System Version 4.0 Software 
 
Several new features have been implemented in the Venable RLC System Version 4.0 
Software: 

05/21/19  5



 
• The software has been updated to work with the newly introduced Venable 

Series 43xx/63xx/350c System analyzers. 
 

• The software now works with Windows 7 32bit and Windows 7 64bit. 
 

• The software now works with Windows 8 32bit and Windows 8 64bit. 
 

• Software Serial Numbers now license individual PCs replacing the separate Site 
Codes.  The license activation process has been revamped to reduce errors. 
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Installation Procedure for use with USB Interface 
 
This is the step-by-step software and hardware installation procedure for our USB 
controlled analyzers. 
 
Note:  Use of the USB interface requires the Venable analyzer to be running 
application firmware version 2.0 or later. 
 
1. If the National Instruments GPIB drivers are installed on your computer, check to 

see if the National Instruments VISA driver is installed. If the NI VISA driver is 
installed, you will need to uninstall it before installing the Keysight drivers. Use the 
windows control panel -> programs function to check for NI VISA installation. 

 
2.  Close all your programs and insert the Venable installation disk into your CD-ROM 

drive. The CD should auto-run and the installation window should open up, 
otherwise browse the CD with Windows Explorer and double-click on 
VenableInstaller.  Once the installer menu opens up, click on the Install button for 
the Keysight IO libraries Suite. Follow the instructions and install using “typical 
settings” option.  

 
3. Install the Venable Windows software.  

 
Click on the Install button for the Venable Software.  Make sure you have your 
software serial number at hand and follow the instructions. 
 
The Venable software is protected against illegal copying and use. In order to run, it  
must be activated by the Licensing Wizard program.  On installation, this program is 
accessible from Start -> All Programs -> Venable Software License.  After you 
activate your first license, this shortcut is replaced by a shortcut to the Venable 
Software for that type of license; in this case you can start the Venable Software and 
choose menu item, Help -> Licenses, then press the Change License button. 
 
Manuals for the Venable software, Manual.pdf, and the Licensing Software, 
LicenseManual.pdf, are included in the installation directory.  These manuals are in 
Adobe portable document format (pdf) and are compatible with Adobe Acrobat 
Reader version 6.0 and above.  An installation program for Adobe Acrobat Reader 
can be downloaded at www.adobe.com.  From the Venable software program you 
can open the manual using the menu item, “Help -> Venable Manual”; similarly from 
the Venable Licensing Software, you can open the licensing manual using the menu 
item, “Help -> License Manual”. 
 
If you need to uninstall the software for any reason, use Add/Remove Programs and 
choose the uninstall option. 
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4.  Connect a standard USB cable to the analyzer. Plug the other end of the USB cable 
into a USB port on the PC. Turn on the Venable FRA analyzer. 

 
5.  Set the software settings.  Open the Venable System Software by selecting: Start 

Menu>>Programs>>Venable type Software.  Select View from the program pull-
down menu and click on Settings. Select the Interface Name from the pulldown and 
set it to USB. Select the FRA Model Number from the pulldown and set it to your 
model of analyzer.  Next, enter the serial number of the analyzer into the box for 
FRA Serial Number.  

 

 
 

RLC Settings Window for 63xx/43xx/51xx/74xx/88xx/350c 
 
 
 When you shutdown the application, the values will be saved into the windows 

registry. 
 
6. If any problem occurs with the Venable software attempting to communicate to the 

analyzer, open the Keysight Connection Expert utility. The Keysight Connection 
Expert should automatically perform a verification of any new connections and the 
analyzer should appear in the list under the USB interface with a green check box. If 
the instrument is checked with a red X, cycle the power on the analyzer to reset the 
connection. 
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Installation Procedure for use with GPIB Adapter 
 
This is the step-by-step software and hardware installation procedure for our GPIB 
controlled analyzers. 
 
1. Before installing the GPIB card in the PC you plan to use, install the National 

Instruments GPIB card driver software, version 17.6.0 or later.  Close all your 
programs and insert the National Instruments CD into your CD-ROM drive.  The 
CD should auto-run and the installation window should open up, otherwise browse 
the CD with Windows Explorer and double-click on Setup.  Left-click on Install NI-
488.2 Software for Windows.  Follow the instructions.  You need only the default 
installation of the software and you do not need to enable DOS.  

 
Note:  Always install the GPIB driver software FIRST.  The GPIB card won’t work 
otherwise.  You will have to uninstall the software and the card and then re-install 
them in the correct order. 
 
2. Turn the computer off, then install the National Instruments GPIB card in the 

computer.  It is available in ISA, PCI, GPIB-USB, and PCMCIA versions.  The 
software for all versions is the same.  When you turn the computer back on, it 
should recognize the GPIB card as part of the boot-up process.  The NI-488.2 
Getting Started Wizard window will open up in the lower right corner of your 
screen.  If you want to double-check your installation, left-click on “Verify your 
hardware and software installation”.  If the installation is correct, your status will be 
passed in the NI-488.2 Troubleshooting Wizard window when the testing is done.  
Click on Exit when your status is verified.  Skip the rest of the steps by closing the 
Getting Started window.  These steps are not needed. 

 
3. Close all your programs and insert the Venable installation disk into your CD-ROM 

drive. The CD should auto-run and the installation window should open up, 
otherwise browse the CD with Windows Explorer and double-click on 
VenableInstaller. Once the installer menu opens up, click on the Install button for 
the Venable Software. Make sure you have your software serial number at hand 
and follow the instructions. 
 
The Venable software is protected against illegal copying and use. In order to run,  
it must be activated by the Licensing Wizard program.  On installation, this program 
is accessible from Start -> All Programs -> Venable Software License.  After you 
activate your first license, this shortcut is replaced by a shortcut to the Venable 
Software for that type of license; in this case you can start the Venable Software 
and choose menu item, Help -> Licenses, then press the Change License button. 
 
Manuals for the Venable software, “RLC Manual.pdf”, and the Licensing Software, 
LicenseManual.pdf, are included in the installation directory.  These manuals are in 
Adobe portable document format (pdf) and are compatible with Adobe Acrobat 
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Reader version 6.0 and above.  An installation program for Adobe Acrobat Reader 
can be downloaded at www.adobe.com.  From the Venable software program you 
can open the manual using the menu item, “Help -> Venable RLC Manual”; 
similarly from the Venable Licensing Software, you can open the licensing manual 
using the menu item, “Help -> License Manual”. 
 
If you need to uninstall the software for any reason, use Add/Remove Programs 
and choose the uninstall option. 

 
4. For hardware models 350/220/260 and HP3577, verify the hardware GPIB address 

is 8. 
 
Verify that address 8 is set on the 250 and 350 analyzers by locating the 8-position 
DIP switch module on the rear panel of the analyzer.  The upper 3 switches should 
always be at 0.  All ADDRESS switches should be at 0 except the fourth from the 
bottom, which should be 1. This sets the analyzer to address 8 on the IEEE-488 
bus.  On the newer 350 analyzers address weights instead of switch numbers are 
printed on the DIP switch module as seen below.   

 
1 20 1 
2 21 2 
3 22 4 
4 23 8 
5 24 16 

 
Address weight when switch is set to one 

 
 The 220 system has no rear panel switches and you must turn on the analyzer to 

verify the GPIB address is set to 8.  After the analyzer completes start up self-
calibration, press the spot set up button above the analyzer power switch.  Keep 
pressing the spot set up button to scroll through the analyzer settings until you 
reach the address setting.  To set the address to eight, press 8 on the front panel 
and one of the three enter keys.  The analyzer ‘s GPIB address is now set to 8. 
This step is not applicable for the RLC software. 
 
Verify that GPIB address 8 is set on the HP3577 by turning on the analyzer.  The 
HP3577 has no address switches and you must turn on the analyzer to verify the 
GPIB address.  After the power up self-tests, press the button marked LCL under 
the SYSTEM menu on the front panel of the analyzer.  Press the ANALYZER 
ADDRESS button on the display. Type in the appropriate address on the keypad, if 
necessary, and press the ENTER button on the display.  The GPIB address is set 
and stored. This step is not applicable for the RLC software. 
 

5. Verify the software settings are correct.  Open the Venable System Software by 
selecting: Start Menu>>Programs>>Venable type Software Select View from the 
program pull-down menu and click on Settings. Ensure the GPIB address is set at 
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8, which is the factory default address on your analyzer.  Make sure the selected 
interface name is set to the default GPIB0.  In the special case where there is more 
than one GPIB card or interface installed on the computer, the interface name may 
have to be changed in order to select the correct card to communicate with the 
analyzer.  Click on OK and select Actions from the program pull-down menu and 
open the Analyzer Control Menu.  Click on the Take Data at Start Freq button to 
enable the new address setting.  When you shutdown the application the new 
address will be stored in the VenPreftype.txt file. 

  

  
 

Venable Settings Window for series 63xx/43xx/51xx/74xx/88xx/350c 
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Settings Window 
The Settings window consists of two sections: hardware, and default plot. 
 

 
Figure 1. Settings window 

 
 In the “hardware” section, the following parameters are defined: 
 
• Analyzer: currently the supported FRAs are the Venable models 350, 3120, 3215, 

3225, and model series 43xx, 51xx, 63xx, 74xx, 88xx and 350c. 
 
• Interface Name: The interface name drop-down list box is used to select a logical 

name for a GPIB adapter or a USB connection. GPIB0 is the default interface name 
when one GPIB adapter is installed. If there is more than one GPIB adapter installed 
on a computer, the interface name may have to be changed depending on which 
adapter is used to communicate with the analyzer. If a USB interface is selected, 
you will be required to fill in the FRA Serial Number and FRA Model Number fields 
below. 

 
• GPIB address: Entering a new address in this text box changes the software GPIB 

address. The user must communicate with the analyzer to reprogram the analyzer’s 
GPIB address after setting the new software address. To communicate with 
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analyzer, open the Analyzer Control Menu and click on the Take Data at Start Freq 
or the Run Sweep button to reprogram the analyzer address. 

 
• FRA Serial Number: User enters the serial number of the FRA being used. It is used 

by the software to establish a USB connection to the instrument.  
  
• FRA Model Number: User enters the model number of the FRA being used. It is   

used by the software to establish a USB connection to the instrument.  
  
• Reference resistor: This is the value, in Ohms, of the resistor used inside the RLC 

box to measure current. The Venable RLC boxes use 100 Ohm reference resistors. 
 

 
 
In the “default plot” section you can choose the type of plot that will be used whenever 
you create a new document. Possible options are “Impedance plot” and “Nyquist plot”. If 
the “Automatically use the default type” option is checked, you won’t be prompted for a 
plot type every time that you create a new one. 
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RLC Control Panel 

Measurement Tab 

 
Figure 2. The Measurement tab 

 
Before measurements can be taken, the system must be calibrated. The purpose of the 
calibration process is to quantify the parasitic components that are present in the RLC 
box. With an estimation of the values of these parasitic elements, the actual 
measurements of RLC circuits can be corrected to improve accuracy. The parasitic 
components are usually modeled as two elements: one in series (of inductive nature), 
and one in parallel (of capacitive nature). 
 
Channel Select:  (Models 74xx and 350c only) 
 
Channel Select allows the RLC box to be used on alternative channel combinations for 
analyzers with 3 or 4 channels. 
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Peak Voltage Select:  (Models 43xx, 51xx, 63xx, 74xx, 88xx and 350c only) 
 
Peak Voltage Select should be set to the peak combined AC and DC voltage level to be 
measured. Slight variances, due to channel input attenuation settings above 10V on the 
input, requires this setting to be set correctly for the calibration to be done based on the 
combined peak voltage level. Once the calibration has been completed, this value 
cannot be changed without closing and reopening the application. On an analyzer with 3 
or more channels, the setting can be changed when the channel select is changed to a 
new setting. (This feature was added to correct for channel input attenuation changes 
during autoranging in data plots at voltage levels above 10V and requires FRA 
application firmware version 1.9, version 2.9, or version 4.1 and higher) 
 
 
 
 
 

 
Figure 3. Parasitic model 

 
The calibration process consists of two steps: an open-circuit sweep, and a closed-
circuit sweep. Once the calibration process starts, the RLC software will prompt you to 
first open and then close the circuit in order to take the respective measurements. 
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Open Circuit Sweep 

When the circuit is open, the impedance of the parallel parasitic element can be 
calculated (the impedance of the series element is so much smaller that its effect is 
negligible in the calculation). 
 

 
Figure 4. Open circuit model 

 

Closed Circuit Sweep 

After the open-circuit sweep is complete, a closed-circuit sweep is run. In this case, the 
parallel element can be removed from the equation, and the impedance of the series 
element can be calculated. 
 

 
Figure 5. Closed circuit model 

 
After the open-circuit and closed-circuit sweeps are complete, you can save the 
calibration data for future use. That way, it is not necessary to re-calibrate before every 
session of measurements. 
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Figure 6. Example of open and closed circuit impedance and phase plots 

 
Once the calibration is done, the system is ready to measure RLC circuits. After 
sweeping through the frequency range, the software will automatically correct the raw 
data and create another plot with the tag “w/o parasitics”. This plot is the result of 
subtracting the series and parallel parasitic elements from the raw data. 
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Figure 7. Uncorrected and corrected plots 

 
The parameters related to measurements are in the “FRA Settings” section: 
 
• Single point or sweep: a single point measurement is done at a specified frequency. 

A sweep is a series of measurements taken throughout a range of frequencies, from 
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the start frequency to the stop frequency, and with a resolution of 10 steps per 
decade. 

 
• Start and stop frequencies: they define the first and last points in the sweep. In the 

case of a single point setup, only the start frequency is relevant. 
 
• Integration time: specifies the length of time over which each sample is taken. There 

are four possible settings: 10 s, 2.5 s, 0.33 s, and 0.05 s. A slower setting will take 
longer to run but will produce more precise results. 

 
• A/C and D/C voltages: they specify the injection voltages. 
 
• Input coupling: specifies whether the input coupling is A/C or D/C. 
 
• Limit maximum phase change between data points: without this option, the software 

will always take 10 data points per frequency decade, regardless of the results. A 
possible problem arises when a sweep involves a resonant point, where the 
impedance changes abruptly from one frequency to the next. In this case, you can 
use this feature to mitigate the problem. If, for example, you set the maximum phase 
change at 20°, the software will adapt its frequency interval so that no two points will 
be more than 20° apart in phase. 

 

Modeling Tab 
The modeling tab is used to create a theoretical model out of the circuit that was 
measured. You can choose the component type and the data set to model. The 
available component types are different combinations of a resistor, a capacitor, and an 
inductor, arranged in parallel or in series. After selecting the component type and data 
set, the calculated theoretical values for R, L, and C are displayed on the window. You 
can also override the values of R, L, and C by typing different values in the respective 
controls. You can create a plot that will represent the theoretical RLC circuit based on 
the values shown. If you wish to create a model with more than three components, you 
could create multiple models and combine them in series or in parallel using the math 
functions. 
 
The theoretical values of the circuit components are calculated by attempting to fit the 
model to the measured data. In the case of components in series, the maximum or 
minimum values of susceptance (for capacitive or inductive circuits, respectively) are 
used to calculate the capacitance or inductance. In the case of components in parallel, 
the maximum or minimum values of reactance (for inductive or capacitive circuits, 
respectively) are used. In order to more accurately calculate the theoretical model, it is 
better to sweep through a wide frequency range. 
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Figure 2. The modeling tab 
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Figure 3. Example of a measured RC circuit and its derived model 
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Reporting Tab 
The RLC application can generate reports in Microsoft Excel XML format, which is 
supported by Microsoft Excel version 2003 and later. The reports include the data in 
tabular format (optionally with voltage data), and information about the model. To 
enhance a report, you can copy a chart to the clipboard (with the “Copy Graph” menu 
item) and then paste it in an Excel spreadsheet. Also, the drawing of the circuit model 
can be copied by pressing CTRL-C while in the “Model” tab. 
 
Alternatively to using the “XML report” feature, you can copy a dataset (first select it on 
the graph, then copy it with CTRL-C) and then paste the data in any text editor, word 
processor, or spreadsheet software. 
 
NOTE: when you copy a dataset to the clipboard, you can control whether the data is 
copied as impedance/phase or as voltage/phase by using the item “Voltage Format” in 
the “Edit” menu. 
 

 
Figure 4. Reporting tab 
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Working with Documents, Views, and Data Sets 
The RLC application can contain multiple documents. A document is a collection of one 
or more data sets (plots). The data contained in a document is shown to you through a 
view window. There are four different types of views: 
 
• Impedance: impedance magnitude and phase versus frequency. 
• Gain: gain magnitude and phase versus frequency. 
• Nyquist: resistance versus reactance. 
• Text: impedance magnitude and phase versus frequency. 
 
When the application starts, it creates an empty document and shows an impedance 
view for that document. You can create new documents and open and save existing 
documents. 
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Manipulating Data Set Properties 

A data set is a collection of data points obtained by running a sweep through a range of 
frequencies. A document can contain multiple data sets. To select a data set, simply 
click any part of the curve with the mouse pointer, or use the “up” and “down” keys to 
cycle through the collection of data sets. The properties of a data set can be viewed and 
edited by selecting “Data Set Properties” from the “View” menu. The Data Set 
Properties dialog shows the current data set number, name, type, and description. You 
can specify whether the data set should be visible, and whether the description should 
be shown on the screen. The colors are also editable. The “voltage node”, “current 
node”, and “scale factor” determine how the impedance is calculated, according to the 
formula shown on the dialog. For acquired data, the voltage node is by default channel 
#2, the current node is channel #1, and the scale factor is the negative of the reference 
resistor (defined in the “Setup” tab). 
 

 
Figure 5. Data set properties 
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Manipulating Graph Properties 

The properties related to a graph (view) can be edited by selecting the “Graph 
Properties” from the “View” menu. 
 

 
Figure 6. Graph settings 

 
This window allows you to select the plot type, change the grid color, select whether the 
graph title and legend are shown, and define the scaling parameters. 
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Working with Slide Bars 

Slide bars are useful for tracking and displaying data values at a specific frequency, 
represented by a vertical line, and a description box.  To create a slide bar, select “Add 
Slide Bar” from the “View” menu.  More than one slide bar may be opened at one time, 
either from the same or different data sets.  “Add Slide Bar” is not available in a text 
display window. 
 
The bar can be dragged using the mouse pointer (except in Nyquist plots, where only 
the Left or Right keys may be used), and the box will show the data at the selected 
frequency. The frequency can also be typed in, and the line will move to that frequency. 
The information shown on the slide bar window is frequency, impedance magnitude and 
phase, and calculated values for R and L or C for the equivalent RL or RC circuit. The 
“Equivalent Circuit” button determines whether the equivalent circuit is series or parallel. 
 

 
Figure 7. Slidebar example 

 
You can use the left or right keys to move the slide bar between data points taken by 
the analyzer.  The shift+left or shift+right key combinations find the 0 degree, +/-90 
degree, or the +/-180 degree phase points if they exist. The ctrl+left or ctrl+right key 
combinations find the 0 dB crossing point if it exists. 
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Math Operations 

The RLC application can apply math functions to one or two data sets. To do this, select 
the “Math Menu” item from the “Actions” menu. 
 

 
Figure 8. Math menu 

 
The possible operations are: add, subtract, multiply, divide, add in parallel, subtract in 
parallel, invert, negate, and create transfer function. The “create transfer function” 
operation divides two plots and shows the result in a new gain/phase view. 

Table 1. Math functions 

Operation Name Function Application 
Add Z = Z1 + Z2 Cascading filters 

Subtract Z = Z1 - Z2 Removing series parasitic 

Multiply Z = Z1 x Z2 Combining gain stages 

Divide Z = Z1 / Z2  

Add in parallel Z = (Z1 x Z2) / (Z1 + Z2) Combining filters 

Subtract in parallel Z = (Z1 x Z2) / (Z1 - Z2) Removing parallel parasitic 

Invert Y = 1 / Z1 Impedance to admittance 

Negate Z = -Z1 180° phase shift 

Create transfer function Z = Z1 / (Z1 + Z2) Filter attenuation 
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Appendix A - The RLC Box 
The Venable FRA models 350, 3120, 3215, 3225, 43xx, 51xx, 63xx, 74xx, 88xx and 
350c have custom RLC boxes that plug directly into the analyzer in order to minimize 
parasitics. The following is a schematic of the circuit used in the Venable RLC boxes. 
The reference resistor value is 100 Ohms, 0.1% which can be changed out if needed. 
 

 
Figure 9. RLC Box Schematic 

 
The following is a picture of an RLC box with the axial lead adapter inserted into it. 
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Appendix B – Specifications 

Calibration Specifications for 5140, 63xx, 74xx, 88xx & 350c Analyzers 
 

Generator Output Tests:  Test 10 
 
DC Bias: Resolution:   10mV 
  Accuracy:   +/- 1.0% of Range Full Scale (10VDC) 
 
 
Square Wave Accuracy:  +/- 1.0% of Range Full Scale  (all ranges except 10mV) 
 
    +/- 1.5% of Range Full Scale  (10mV range only) 
 

Output ranges  
Range 
10 mVpk 
31.6 mVpk 
100 mVpk 
316 mVpk 
1 Vpk 
3.16 Vpk 
10 Vpk 

 
 
Sine Wave AC Amplitude Accuracy: 
 
 +/-(1.0% + 1%/MHz) of Range Full Scale  (all ranges except 10mV & 30mV) 
 
 +/-(1.8% + 1%/MHz) of Range Full Scale  (30mV range only) 
 
 +/-(2.6% + 1%/MHz) of Range Full Scale  (10mV range only) 
 

 Resolution:  Depends on the range setting (see table below) 
 

Output ranges and resolution 
Range Sensitivity 
10 mVpk 10uV 
31.6 mVpk 30uV 
100 mVpk 100uV 
316 mVpk 300uV 
1 Vpk 1 mV 
3.16 Vpk 3 mV 
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10 Vpk 10 mV 

Channel Input Tests 
 
Amplitude Accuracy:  Tests 20 - 26 
 
>= 1 MHz:  +/- (1.0% + 1.3%/MHz) of Range Full Scale  (all ranges) 

 
  < 1 MHz:  +/- (0.4% + 1.3%/MHz) of Range Full Scale  (all ranges except 10mV) 
 
  < 1 MHz:  +/- (0.6% + 1.6%/MHz) of Range Full Scale  (10mV range only) 
 

Output ranges  
Range 
10 mVpk 
31.6 mVpk 
100 mVpk 
316 mVpk 
1 Vpk 
3.16 Vpk 
10 Vpk 
31.6 Vpk 
100 Vpk 
316 Vpk 
500 Vpk 

 
 
 
Phase Accuracy:  Tests 30 - 59 
 
 +/- (0.4deg + 1.0 deg/MHz) 
 
 
 
Bandwidth Accuracy: Tests 60 - 65 
 
  Amplitude: +/- (0.04 dB + 0.1 dB /MHz) 
 Phase:         +/- (0.4 deg + 1.0 deg/MHz) 
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RLC Specifications 
 

Measurement Frequency 

1 Hz to 40 MHz, user-selectable for single component, selected automatically for 
multiple-component circuit. 

Accuracy 

1 Hz to 1 kHz  0.1% 
1 kHz to 100 kHz  0.2% 
100 kHz to 1 MHz  0.5% 
1 MHz to 10 MHz  1.0% 
10 MHz to 40 MHz  4.0% 

 

Optimum Measurement Range 

Resistance: 10 milliohms to 1 megaohm 
Inductance: 1 microhenry to 10,000 henries 
Capacitance: 100 picofarads to 1 farad 

  

Extended Measurement Range* 

Resistance: 100 micro-ohms to 100 megaohms 
Inductance: 10 nanohenrys to 1 megahenry 
Capacitance: 1 picofarad to 100 farads 

 

* Extended range loses least-significant digit of accuracy for each decade of measured 
value outside the optimum measurement or frequency range. 
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Specifications: Venable 350c, 3 channel, 5, 20, and 40MHz Models 
 

Generator: 
 
Frequency Range: 10µHz to 5, 20, or 40MHz (sine wave) 
 10µHz to 1MHz (square wave) 
AC Amplitude 1mV to 10V 
DC Bias ±10V, 10mV Steps 
Sweep Modes: Single Frequency, logarithmic and linear sweep steps 
 Log Sweep: 0.1 – 2000 Steps per decade  
 Linear Sweep: 1Hz – 5, 20, or 40MHz step 
Output Amplitude  
Compression: Dynamically adjust output to maintain a constant channel input level  
 through Venable software servo 
Output Impedance: Switchable: 50 ohms (default) or high current 2 ohms to 5 MHz 
Output Configuration: Single-ended floating and isolated up to ±600 Vpk 
 
Analyzer: 
 
Frequency Range:  10µHz to 5, 20, or 40MHz 
Input Configuration: Ch.1, 2, and 3:  Single-ended Floating to ±600Vpk 
Input Impedance: Switchable: 50 Ohms or 1 Mega Ohm (default) 
Measurement Accuracy: ± 0.03dB + .1dB/MHz; 
 ± 0.4deg + 1deg/MHz  
Measurement Technique: Narrowband DFT 
 Integration Time: 20msec to 100ksec 
 Delay Time: 0-100ksec 
 Integration Cycles: 1-9999 cycles 
 Delay Cycles: 1-9999 cycles 
Input Coupling: DC with automatic DC offset cancellation 
Input Range: 10mV to 500Vpk Full Scale in 11 ranges, Auto-ranging 
Dynamic Range: 120 dB 
CMRR/IMRR: 120 dB 
Max. Input: ±500Vpk 
Max Input Withstand Voltage: ±600Vpk  
Over-range Alarms: LED indicator 
Calibration: NIST  and Z540.1 standards 
 
System: 
 
PC Interface: USB 2.0 and IEEE 488 (GPIB) 
Auxiliary Output: 12Vdc @ 400mA, 4.8W for accessories 
Application software: Venable Stability Analysis™ for Win 7/8/10 
Real time display update: Each point is plotted as acquired  
Data Analysis: Polar coordinates: Gain magnitude, Phase, Gain margin, and phase  
 margin. 
 Impedance: R, L, C, Z magnitude, and Phase 
Power Supply Requirements: 90 to 264Vac, 48 to 62Hz, 30VA, 
Weight/Dimensions: 12 Lbs. / 17”x 10”x 3.5” 
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Specifications: Venable 5140, 2 channel, 40MHz 
 

Generator: 
 
Frequency Range: 1Hz to 40MHz (sine wave) 
AC Amplitude 10mV to 10V 
DC Bias ±10V, 10mV Steps 
Sweep Modes: Single Frequency, logarithmic and linear sweep steps 
 Log Sweep: 0.1 – 2000 Steps per decade  
 Linear Sweep: 1Hz – 40MHz step 
Output Amplitude  
Compression: Dynamically adjust output to maintain a constant channel input level  
 through Venable software servo 
Output Impedance: 50 ohms 
Output Configuration: Single-ended grounded 
 
Analyzer: 
 
Frequency Range:  1Hz to 40MHz 
Input Configuration: Ch.1: Single-ended Floating to ±600Vpk 
 Ch.2: Single-ended grounded 
Input Impedance: 1 Mega ohm 
Measurement Accuracy: ± 0.03dB + .1dB/MHz; 
 ± 0.4deg + 1deg/MHz  
Measurement Technique: Narrowband DFT 
 Integration Time: 20msec to 100ksec 
 Delay Time: 0-100 sec 
 Integration Cycles: 1-9999 cycles 
 Delay Cycles: 1-9999 cycles 
Input Coupling: DC with automatic DC offset cancellation 
Input Range: 10mV to 10Vpk Full Scale in 7 ranges, Auto-ranging 
Dynamic Range: 120 dB 
CMRR/IMRR: 120 dB 
Max. Input: ±100Vpk 
Max Input Withstand Voltage: ±100Vpk  
Over-range Alarms: LED indicator 
Calibration: NIST Standard 
 
System: 
 
PC Interface: USB 2.0 
Auxiliary Output: 12Vdc @ 400mA, 4.8W for accessories 
Application software: Venable Stability Analysis™ for Win 7/8/10 
Real time display update: Each point is plotted as acquired  
Data Analysis: Polar coordinates: Gain magnitude, Phase, Gain margin, and phase  
 margin. 
 Impedance: R, L, C, Z magnitude, and Phase 
Power Supply Requirements:  90 to 264Vac, 48 to 62Hz, 30VA, 
 24VDC, 24W (Min) 
Weight/Dimensions: 4 Lbs. / 9.8”x 9.8”x 3.2”     
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Specifications: Venable 63XX, 2 channel, 5, 20, and 40MHz Models 
 

Generator: 
 
Frequency Range: 10µHz to 5, 20, or 40MHz (sine wave) 
 10µHz to 1MHz (square wave) 
AC Amplitude 1mV to 10V 
DC Bias ±10V, 10mV Steps 
Sweep Modes: Single Frequency, logarithmic and linear sweep steps 
 Log Sweep: 0.1 – 2000 Steps per decade  
 Linear Sweep: 1Hz – 5, 20, or 40MHz step 
Output Amplitude  
Compression: Dynamically adjust output to maintain a constant channel input level  
 through Venable software servo 
Output Impedance: Switchable: 50 ohms (default) or high current 2 ohms to 5 MHz 
Output Configuration: Single-ended floating and isolated up to ±600 Vpk 
 
Analyzer: 
 
Frequency Range:  10µHz to 5, 20, or 40MHz 
Input Configuration: Ch.1 and 2:  Single-ended Floating to ±600Vpk 
Input Impedance: Switchable: 50 Ohms or 1 Mega Ohm (default) 
Measurement Accuracy: ± 0.03dB + .1dB/MHz; 
 ± 0.4deg + 1deg/MHz  
Measurement Technique: Narrowband DFT 
 Integration Time: 20msec to 100ksec 
 Delay Time: 0-100ksec 
 Integration Cycles: 1-9999 cycles 
 Delay Cycles: 1-9999 cycles 
Input Coupling: DC with automatic DC offset cancellation 
Input Range: 10mV to 500Vpk Full Scale in 11 ranges, Auto-ranging 
Dynamic Range: 120 dB 
CMRR/IMRR: 120 dB 
Max. Input: ±500Vpk 
Max Input Withstand Voltage: ±600Vpk  
Over-range Alarms: LED indicator 
Calibration: NIST  and Z540.1 standards 
 
System: 
 
PC Interface: USB 2.0 and IEEE 488 (GPIB) 
Auxiliary Output: 12Vdc @ 400mA, 4.8W for accessories 
Application software: Venable Stability Analysis™ for Win 7/8/10 
Real time display update: Each point is plotted as acquired  
Data Analysis: Polar coordinates: Gain magnitude, Phase, Gain margin, and phase  
 margin. 
 Impedance: R, L, C, Z magnitude, and Phase 
Power Supply Requirements:  90 to 264Vac, 48 to 62Hz, 30VA, 
Weight/Dimensions: 12 Lbs. / 17”x 10”x 3.5” 
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Specifications: Venable 74XX, 4 channel, 5, 20, and 40MHz Models 
 

Generator: 
 
Frequency Range: 10µHz to 5, 20, or 40MHz (sine wave) 
 10µHz to 1MHz (square wave) 
AC Amplitude 1mV to 10V 
DC Bias ±10V, 10mV Steps 
Sweep Modes: Single Frequency, logarithmic and linear sweep steps 
 Log Sweep: 0.1 – 2000 Steps per decade  
 Linear Sweep: 1Hz – 5, 20, or 40MHz step 
Output Amplitude  
Compression: Dynamically adjust output to maintain a constant channel input level  
 through Venable software servo 
Output Impedance: Switchable: 50 ohms (default) or high current 2 ohms to 5 MHz 
Output Configuration: Single-ended floating and isolated up to ±600 Vpk 
 
Analyzer: 
 
Frequency Range:  10µHz to 5, 20, or 40MHz 
Input Configuration: Ch.1, 2, 3 and 4:  Single-ended Floating to ±600Vpk 
Input Impedance: Switchable: 50 Ohms or 1 Mega Ohm (default) 
Measurement Accuracy: ± 0.03dB + .1dB/MHz; 
 ± 0.4deg + 1deg/MHz  
Measurement Technique: Narrowband DFT 
 Integration Time: 20msec to 100ksec 
 Delay Time: 0-100ksec 
 Integration Cycles: 1-9999 cycles 
 Delay Cycles: 1-9999 cycles 
Input Coupling: DC with automatic DC offset cancellation 
Input Range: 10mV to 500Vpk Full Scale in 11 ranges, Auto-ranging 
Dynamic Range: 120 dB 
CMRR/IMRR: 120 dB 
Max. Input: ±500Vpk 
Max Input Withstand Voltage: ±600Vpk  
Over-range Alarms: LED indicator 
Calibration: NIST  and Z540.1 standards 
 
System: 
 
PC Interface: USB 2.0 and IEEE 488 (GPIB) 
Auxiliary Output: 12Vdc @ 400mA, 4.8W for accessories 
Application software: Venable Stability Analysis™ for Win 7/8/10 
Real time display update: Each point is plotted as acquired  
Data Analysis: Polar coordinates: Gain magnitude, Phase, Gain margin, and phase  
 margin. 
 Impedance: R, L, C, Z magnitude, and Phase 
Power Supply Requirements:  90 to 264Vac, 48 to 62Hz, 30VA, 
Weight/Dimensions: 12 Lbs. / 17”x 10”x 3.5” 
 
 

05/21/19  34



Specifications: Venable 88XX, 23 channel, 5, 20, and 40MHz Models 
 

Generator: 
 
Frequency Range: 10µHz to 5, 20, or 40MHz (sine wave) 
 10µHz to 5MHz (square wave) 
AC Amplitude 1mV to 10V 
DC Bias ±10V, 10mV Steps 
Sweep Modes: Single Frequency, logarithmic and linear sweep steps 
 Log Sweep: 0.1 – 2000 Steps per decade  
 Linear Sweep: 1Hz – 5, 20, or 40MHz step 
Output Amplitude  
Compression: Dynamically adjust output to maintain a constant channel input level  
 through Venable software servo 
Output Impedance: Switchable: 50 ohms (default) or high current 2 ohms to 5 MHz 
Output Configuration: Single-ended floating and isolated up to ±600 Vpk 
 
Analyzer: 
 
Frequency Range:  10µHz to 5, 20, or 40MHz 
Input Configuration: Ch.1 and 2:  Single-ended Floating to ±600Vpk 
Input Impedance: Switchable: 50 Ohms or 1 Mega Ohm (default) 
Measurement Accuracy: ± 0.03dB + .1dB/MHz; 
 ± 0.4deg + 1deg/MHz  
Measurement Technique: Narrowband DFT 
 Integration Time: 20msec to 100ksec 
 Delay Time: 0-999 sec 
 Integration Cycles: 1-9999 cycles 
 Delay Cycles: 1-9999 cycles 
Input Coupling: DC with automatic DC offset cancellation 
Input Range: 10mV to 500Vpk Full Scale in 11 ranges, Auto-ranging 
Dynamic Range: 120 dB 
CMRR/IMRR: 120 dB 
Max. Input: ±500Vpk 
Max Input Withstand Voltage: ±600Vpk  
Over-range Alarms: LED indicator 
Calibration: NIST  and Z540.1 standards 
 
Digital Analyzer: 
 
Frequency Range: 10mHz to 1MHz 
Integration Cycles: 1-10 cycles 
Interface: I2C and Sync Out (3.3V) 
Supported Processors: Contact Venable 
 
System: 
 
PC Interface: USB 2.0 and IEEE 488 (GPIB) 
Auxiliary Output: 12Vdc @ 400mA, 4.8W for accessories 
Application software: Venable Stability Analysis™ for Win 7/8/10 
Real time display update: Each point is plotted as acquired  
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System: (cont.) 
 
Data Analysis: Polar coordinates: Gain magnitude, Phase, Gain margin, and phase  
 margin. 
 Impedance: R, L, C, Z magnitude, and Phase 
Power Supply Requirements:  90 to 264Vac, 48 to 62Hz, 30VA, 
Weight/Dimensions: 12 Lbs. / 17”x 10”x 3.5” 
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APPENDIX C- Hardware Description of Venable Analyzers 
 

350C Front Panel 
 

 
Description 
 

1. Power LED:  This amber LED Illuminates when the power is turned on. 
2. Auxiliary Power Jack: Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box. 
3. Generator LED:  This green LED will flash on and off when power is turned on.  

 It illuminates when the generator is turned on by the user.  
 Normally it is off. 

4. Channel LED: This green LED will flash on and off when power is turned on. The 
 green LED illuminates when the analyzer has finished booting  
 up and indicates that the channel ready for measurements.  
 Normally it is on. A flickering LED indicates that the channel is  

 overloading and trying to clear the overload. If it is off, the  
 channel is malfunctioning or can’t clear the overload. 

5. Power Switch: This switch turns the analyzer on and off. 
6. Generator Output: This is a floating single-ended output. .The output impedance is switchable  

 between 50 Ohms and 2 Ohms (high current). It is isolated and floats to  
 ±600Vpk. 

7. Reference Channel: This channel is not used for measurement. It is used  to measure the  
 oscillator output. 

8. Input Channels: All three channels have single-ended floating inputs switchable between  
 input impedances of 50 Ohms and 1 Mega Ohm (default). They are  
 isolated and float to ±600Vpk. 
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350C/63XX/74XX/88XX Rear Panel 
 

 
Description 
 

1. USB Port: Provides USB 2.0 communication with the Venable software version 5  
 using the Keysight VISA or Venable software version 6 using the Windows  
 USB driver (Win 7 and above). 

2. Ethernet Port This port is primarily used to upgrade the analyzer firmware. 
3. RS-485 Port Not implemented. 
4. Sync Output Outputs a CMOS level square wave signal set to the same frequency as 

 the generator output. 
5. Modulator Input Not implemented. 
6. Fuse Fuse holder for 1A/250 slow-blow fuse. 
7. GPIB Port: Provides IEEE 488 communication for Venable software and test  

 systems. 
8. Accessories Port: DB25 connector to control external accessories and the  

 automated calibration test fixture. 
9. Chassis Ground: Ground terminal that works with bare wire, lugs or banana plug 
10. Power Inlet: Supplies the required 90 to 264Vac, 48 to 62Hz, and 30VA power to 

 the analyzer. 
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5140 Front Panel 
 

 
Description 
 

1. Power LED:  This amber LED Illuminates when the power is turned on. 
2. Auxiliary Power Jack: Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box. 
3. Generator LED:  This green LED will flash on and off when power is turned on. It illuminates  
 when the generator is turned on by the user. Normally it is off. 
4. Channel LED: This green LED will flash on and off when power is turned on. The green  
 LED illuminates when the analyzer has finished booting up and indicates  
 that the channel ready for measurements. Normally it is on. A flickering  
 LED indicates that the channel is overloading and trying to clear the  
 overload. If it is off, the channel is malfunctioning or can’t clear the  
 overload. 
5. Power Switch: This switch turns the analyzer on and off. 
6. Generator Output: This is a grounded single-ended 50 Ohm output. It requires that an  
 injection transformer be used when measuring feedback loops. 
7. Channel 1 Input: This is a single-ended floating 1 Mega Ohm input. It is isolated and floats  
 to ±600Vpk. 
8. Channel 2 Input: This is a grounded single-ended 1 Mega Ohm input 
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5140 Rear Panel 
 

 
Description 

 
9. Chassis Ground: Ground terminal that works with bare wire, lugs or banana plug. 

10. Ethernet Port: This port is primarily used to upgrade analyzer firmware. 
11. USB Port: Provides USB 2.0 communication with the Venable software version 6  
 using the Windows USB driver (Win 7 and above). 
12. Accessories Port: DB25 connector to control external accessories and the  
  automated calibration test fixture. 
13. GPIB Port: Provides IEEE 488 communication for test systems. 
14. DC Power Inlet: Supplies the required 24VDC voltage and 24W (Min) power to the  
  analyzer. 
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63XX Front Panel 

 
Description 
 

1. Power LED:  This amber LED Illuminates when the power is turned on. 
2. Auxiliary Power Jack: Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box. 
3. Generator LED:  This green LED will flash on and off when power is turned on.  

 It illuminates when the generator is turned on by the user.  
 Normally it is off. 

4. Channel LED: This green LED will flash on and off when power is turned on. The 
 green LED illuminates when the analyzer has finished booting  
 up and indicates that the channel ready for measurements.  
 Normally it is on. A flickering LED indicates that the channel is  

 overloading and trying to clear the overload. If it is off, the  
 channel is malfunctioning or can’t clear the overload. 

5. Power Switch: This switch turns the analyzer on and off. 
6. Generator Output: This is a floating single-ended output. .The output impedance is switchable  

 between 50 Ohms and 2 Ohms (high current). It is isolated and floats to  
 ±600Vpk. 

7. Input Channels: Both channels have single-ended floating inputs switchable between input  
 impedances of 50 Ohms and 1 Mega Ohm (default). They are isolated and  
 float to ±600Vpk. 
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74XX Front Panel 

 
Description 
 

1. Power LED:  This amber LED Illuminates when the power is turned on. 
2. Auxiliary Power Jack: Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box. 
3. Generator LED:  This green LED will flash on and off when power is turned on.  

 It illuminates when the generator is turned on by the user.  
 Normally it is off. 

4. Channel LED: This green LED will flash on and off when power is turned on. The 
 green LED illuminates when the analyzer has finished booting  
 up and indicates that the channel ready for measurements.  
 Normally it is on. A flickering LED indicates that the channel is  

 overloading and trying to clear the overload. If it is off, the  
 channel is malfunctioning or can’t clear the overload. 

5. Power Switch: This switch turns the analyzer on and off. 
6. Generator Output: This is a floating single-ended output. .The output impedance is switchable  

 between 50 Ohms and 2 Ohms (high current). It is isolated and floats to  
 ±600Vpk. 

7. Input Channels: All four channels have single-ended floating inputs switchable between  
 input impedances of 50 Ohms and 1 Mega Ohm (default). They are  
 isolated and float to ±600Vpk. 
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88XX Front Panel 

 
Description 
 

1. Power LED:  This amber LED Illuminates when the power is turned on. 
2. Auxiliary Power Jack: Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box. 
3. Generator LED:  This green LED will flash on and off when power is turned on.  

 It illuminates when the generator is turned on by the user.  
 Normally it is off. 

4. Channel LED: This green LED will flash on and off when power is turned on. The 
 green LED illuminates when the analyzer has finished booting  
 up and indicates that the channel ready for measurements.  
 Normally it is on. A flickering LED indicates that the channel is  

 overloading and trying to clear the overload. If it is off, the  
 channel is malfunctioning or can’t clear the overload. 

5. Power Switch: This switch turns the analyzer on and off. 
6. Generator Output: This is a floating single-ended output. .The output impedance is switchable  

 between 50 Ohms and 2 Ohms (high current). It is isolated and floats to  
 ±600Vpk. 

7. Input Channels: Both analog channels have single-ended floating inputs switchable  
 between input impedances of 50 Ohms and 1 Mega Ohm (default). They  
 are isolated and float to ±600Vpk. 
8. Digital I/O Port: This port used to connect to a target processor in a digital power supply. 

 A special cable is used and the connection consists of an I2C bus, a sync  
 signal and a ground. 
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